PowerPoint > Accessibility
Keyboard shortcuts for use while creating a presentation in PowerPoint 2010
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Key to using keyboard shortcuts
The keyboard shortcuts described in this Help topic refer to the U.S. keyboard layout. Keys on other layouts might not correspond exactly to the keys on a U.S. keyboard.
For keyboard shortcuts in which you press two or more keys at the same time, the keys to press are separated by a plus sign (+). For keyboard shortcuts in which you press one key immediately followed by another key, the keys to press are separated by a comma (,).
NOTE To print this topic, press TAB to select Show All, press ENTER, and then press CTRL+P.
Online Help
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The Help window provides access to all Office Help content. The Help window displays topics and other Help content.
In the Help window
	To do this
	Press

	Open the Help window.
	F1

	Close the Help window.
	ALT+F4

	Switch between the Help window and the active program.
	ALT+TAB

	Go back to PowerPoint Help and How-to table of contents.
	ALT+HOME

	Select the next item in the Help window.
	TAB

	Select the previous item in the Help window.
	SHIFT+TAB

	Perform the action for the selected item.
	ENTER

	In the Browse PowerPoint Help section of the Help window, select the next or previous item, respectively.
	TAB, SHIFT+TAB

	In the Browse PowerPoint Help section of the Help window, expand or collapse the selected item, respectively.
	ENTER

	Select the next hidden text or hyperlink, including Show All or Hide All at the top of a topic.
	TAB

	Select the previous hidden text or hyperlink.
	SHIFT+TAB

	Perform the action for the selected Show All, Hide All, hidden text, or hyperlink.
	ENTER

	Move back to the previous Help topic (Back button).
	ALT+LEFT ARROW or BACKSPACE

	Move forward to the next Help topic (Forward button).
	ALT+RIGHT ARROW

	Scroll small amounts up or down, respectively, within the currently displayed Help topic.
	UP ARROW, DOWN ARROW

	Scroll larger amounts up or down, respectively, within the currently displayed Help topic.
	PAGE UP, PAGE DOWN

	Display a menu of commands for the Help window. This requires that the Help window have the active focus (click in the Help window).
	SHIFT+F10

	Stop the last action (Stop button).
	ESC

	Refresh the window (Refresh button).
	F5

	Print the current Help topic. 
NOTE If the cursor is not in the current Help topic, press F6 and then press CTRL+P.
	CTRL+P

	Change the connection state. You may need to press F6 more than once. 
	F6 (until the focus is in the Type words to search for box), TAB, DOWN ARROW

	Type text in the Type words to search for box. You may need to press F6 more than once.
	F6

	Switch among areas in the Help window; for example, switch between the toolbar, Type words to search for box, and Search list.
	F6

	In a Table of Contents in tree view, select the next or previous item, respectively.
	UP ARROW, DOWN ARROW

	In a Table of Contents in tree view, expand or collapse the selected item, respectively.
	LEFT ARROW, RIGHT ARROW


Microsoft Office basics
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	To do this
	Press

	Switch to the next window.
	ALT+TAB, TAB

	Switch to the previous window.
	ALT+SHIFT+TAB, TAB

	Close the active window.
	CTRL+W or CTRL+F4

	Broadcast the open presentation to a remote audience using the PowerPoint web application.
	CTRL+F5

	Move to the next task pane (task pane: A window within an Office program that provides commonly used commands. Its location and small size allow you to use these commands while still working on your files.) from another pane in the program window (clockwise direction). You may need to press F6 more than once. 
NOTE If pressing F6 does not display the task pane that you want, press ALT to put the focus on the Ribbon, and then press CTRL+TAB to move to the task pane.
	F6

	Move to a pane from another pane in the program window (counterclockwise direction).
	SHIFT+F6

	When more than one PowerPoint window is open, switch to the next PowerPoint window.
	CTRL+F6

	Switch to the previous PowerPoint window.
	CTRL+SHIFT+F6

	Copy a picture of the screen to the Clipboard.
	PRINT SCREEN

	Copy a picture of the selected window to the Clipboard.
	ALT+PRINT SCREEN
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NOTE The cursor needs to be inside a text box to use these shortcuts.
	To do this
	Press

	Change the font.
	CTRL+SHIFT+F

	Change the font size.
	CTRL+SHIFT+P

	Increase the font size of the selected text.
	CTRL+SHIFT+>

	Decrease the font size of the selected text.
	CTRL+SHIFT+<
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	To do this
	Press

	Move one character to the left.
	LEFT ARROW

	Move one character to the right.
	RIGHT ARROW

	Move one line up.
	UP ARROW

	Move one line down.
	DOWN ARROW

	Move one word to the left.
	CTRL+LEFT ARROW

	Move one word to the right.
	CTRL+RIGHT ARROW

	Move to the end of a line.
	END

	Move to the beginning of a line.
	HOME

	Move up one paragraph.
	CTRL+UP ARROW

	Move down one paragraph.
	CTRL+DOWN ARROW

	Move to the end of a text box.
	CTRL+END

	Move to the beginning of a text box.
	CTRL+HOME

	In Microsoft Office PowerPoint, move to the next title or body text placeholder. If it is the last placeholder on a slide, this will insert a new slide with the same slide layout as the original slide.
	CTRL+ENTER

	Repeat the last Find action.
	SHIFT+F4
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	To do this
	Press

	Open the Find dialog box.
	CTRL+F

	Open the Replace dialog box.
	CTRL+H

	Repeat the last Find action.
	SHIFT+F4
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	To do this
	Press

	Move to the next cell.
	TAB

	Move to the preceding cell.
	SHIFT+TAB

	Move to the next row.
	DOWN ARROW

	Move to the preceding row.
	UP ARROW

	Insert a tab in a cell.
	CTRL+TAB

	Start a new paragraph.
	ENTER

	Add a new row at the bottom of the table.
	TAB at the end of the last row
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	To do this
	Press

	Move to a task pane (task pane: A window within an Office program that provides commonly used commands. Its location and small size allow you to use these commands while still working on your files.) from another pane in the program window. (You may need to press F6 more than once.)
	F6

	When a task pane is active, select the next or previous option in the task pane, respectively.
	TAB, SHIFT+TAB

	Display the full set of commands on the task pane menu.
	CTRL+DOWN ARROW

	Move among choices on a selected submenu; move among certain options in a group of options in a dialog box.
	DOWN ARROW or UP ARROW

	Open the selected menu, or perform the action assigned to the selected button.
	SPACEBAR or ENTER

	Open a shortcut menu; open a drop-down menu for the selected gallery item.
	SHIFT+F10

	When a menu or submenu is visible, select the first or last command, respectively, on the menu or submenu.
	HOME, END

	Scroll up or down in the selected gallery list, respectively.
	PAGE UP, PAGE DOWN

	Move to the top or bottom of the selected gallery list, respectively.
	HOME, END

	Close a task pane.
	CTRL+SPACEBAR, C

	Open the Clipboard.
	ALT+H, F, O
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1. In the task pane (task pane: A window within an Office program that provides commonly used commands. Its location and small size allow you to use these commands while still working on your files.), press CTRL+SPACEBAR to display a menu of additional commands. 
2. Use the DOWN ARROW key to select the Size command, and then press ENTER. 
3. Use the arrow keys to resize the task pane. Use CTRL+ the arrow keys to resize one pixel at a time. 
NOTE When you finish resizing, press ESC.
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	To do this
	Press

	Move to the next option or option group.
	TAB

	Move to the previous option or option group.
	SHIFT+TAB

	Switch to the next tab in a dialog box. (A tab must already be selected in an open dialog box) 
	DOWN ARROW

	Switch to the previous tab in a dialog box. (A tab must already be selected in an open dialog box)
	UP ARROW

	Open a selected drop-down list.
	DOWN ARROW, ALT+DOWN ARROW

	Open the list if it is closed and move to an option in the list.
	First letter of an option in a drop-down list

	Move between options in an open drop-down list, or between options in a group of options.
	UP ARROW, DOWN ARROW

	Perform the action assigned to the selected button; select or clear the selected check box.
	SPACEBAR

	Select an option; select or clear a check box.
	The letter underlined in an option

	Perform the action assigned to a default button in a dialog box.
	ENTER

	Close a selected drop-down list; cancel a command and close a dialog box.
	ESC
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An edit box is a blank box in which you type or paste an entry, such as your user name or the path of a folder.
	To do this
	Press

	Move to the beginning of the entry.
	HOME

	Move to the end of the entry.
	END

	Move one character to the left or right, respectively.
	LEFT ARROW, RIGHT ARROW

	Move one word to the left.
	CTRL+LEFT ARROW

	Move one word to the right.
	CTRL+RIGHT ARROW

	Select or cancel selection one character to the left.
	SHIFT+LEFT ARROW

	Select or cancel selection one character to the right.
	SHIFT+RIGHT ARROW

	Select or cancel selection one word to the left.
	CTRL+SHIFT+LEFT ARROW

	Select or cancel selection one word to the right.
	CTRL+SHIFT+RIGHT ARROW

	Select from the cursor to the beginning of the entry.
	SHIFT+HOME

	Select from the cursor to the end of the entry.
	SHIFT+END
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	To do this
	Press

	Open the Open dialog box
	ALT+F then O

	Open the Save As dialog box
	ALT+F then A

	Move between options in an open drop-down list, or between options in a group of options
	Arrow keys

	Display a shortcut menu for a selected item, such as a folder or file.
	SHIFT+F10

	Move between options or areas in the dialog box. 
	TAB

	Open the filepath drop-down menu
	F4 or ALT+I

	Refresh the file list.
	F5


Navigating the Ribbon
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1. Press ALT. 
The KeyTips are displayed over each feature that is available in the current view. 
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2. Press the letter shown in the KeyTip over the feature that you want to use. 
3. Depending on which letter you press, you may be shown additional KeyTips. For example, if the Home tab is active and you press N, the Insert tab is displayed, along with the KeyTips for the groups on that tab. 
4. Continue pressing letters until you press the letter of the command or control that you want to use. In some cases, you must first press the letter of the group that contains the command. For example, if the Home tab is active, press ALT+H, F, S will take you to the Size list box in the Font group. 
NOTE To cancel the action that you are taking and hide the KeyTips, press ALT.
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Another way to use the keyboard to work with the Ribbon is to move the focus among the tabs and commands until you find the feature that you want to use. The following table lists some ways to move the keyboard focus without using the mouse.
	To do this
	Press

	Select the active tab of the Ribbon and activate the access keys (access key: A key combination, such as ALT+F, that moves the focus to a menu, command, or control, without using the mouse.).
	ALT or F10. Press either of these keys again to move back to the document and cancel the access keys.

	Move left or right to another tab of the Ribbon, respectively.
	F10 to select the active tab, and then LEFT ARROW, RIGHT ARROW

	Hide or show the Ribbon.
	CTRL+F1

	Display the shortcut menu for the selected command.
	SHIFT+F10

	Move the focus to select each of the following areas of the window: 
· Active tab of the Ribbon 
· Any open task panes (task pane: A window within an Office program that provides commonly used commands. Its location and small size allow you to use these commands while still working on your files.) 
· Your document
	F6

	Move the focus to each command on the Ribbon, forward or backward respectively.
	TAB, SHIFT+TAB

	Move down, up, left, or right among the items on the Ribbon, respectively.
	DOWN ARROW, UP ARROW, LEFT ARROW, RIGHT ARROW

	Activate the selected command or control on the Ribbon.
	SPACE BAR or ENTER

	Open the selected menu or gallery on the Ribbon.
	SPACE BAR or ENTER

	Activate a command or control on the Ribbon so you can modify a value.
	ENTER

	Finish modifying a value in a control on the Ribbon, and move the focus back to the document.
	ENTER

	Get help on the selected command or control on the Ribbon. (If no Help topic is associated with the selected command, a general Help topic about the program is shown instead.)
	F1


Common tasks in Microsoft Office PowerPoint
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	To do this
	Press

	Move clockwise among panes in Normal view.
	F6

	Move counterclockwise among panes in Normal view.
	SHIFT+F6

	Switch between Slides and Outline tabs in the Outline and Slides pane in Normal view.
	CTRL+SHIFT+TAB
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	To do this
	Press

	Promote a paragraph.
	ALT+SHIFT+LEFT ARROW

	Demote a paragraph.
	ALT+SHIFT+RIGHT ARROW

	Move selected paragraphs up.
	ALT+SHIFT+UP ARROW

	Move selected paragraphs down.
	ALT+SHIFT+DOWN ARROW

	Show heading level 1.
	ALT+SHIFT+1

	Expand text below a heading.
	ALT+SHIFT+PLUS SIGN

	Collapse text below a heading.
	ALT+SHIFT+MINUS SIGN
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1. Press and release ALT, then N, then S, then H to select Shapes. 
2. Use the arrow keys to move through the categories of shapes, and select the shape that you want. 
3. Press CTRL+ENTER to insert the shape that you selected. 
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1. Press and release ALT, then N, and then X. 
2. Press CTRL+ENTER to insert the text box. 
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1. Press and release ALT, then N, then J to select Object. 
2. Use the arrow keys to move through the objects. 
3. Press CTRL+ENTER to insert the object that you want. 
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1. Press and release ALT, then N, then W to select WordArt. 
2. Use the arrow keys to select the WordArt style that you want, and then press ENTER. 
3. Type the text that you want. 
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NOTE If your cursor is within text, press ESC.
· To select a single shape, press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through the objects until sizing handles appear on the object that you want to select.
· To select multiple items, use the selection pane.
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· To group shapes, pictures, or WordArt objects, select the items that you want to group, and then press CTRL+G. 
· To ungroup a group, select the group, and then press CTRL+SHIFT+G. 
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	To do this
	Press

	Show or hide the grid.
	SHIFT+F9

	Show or hide guides.
	ALT+F9
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1. Select the shape with the attributes that you want to copy. 
NOTE If you select a shape with text, you copy the look and style of the text in addition to the attributes of the shape.
2. Press CTRL+SHIFT+C to copy the object attributes. 
3. Press the TAB key or SHIFT+TAB to select the object that you want to copy the attributes to. 
4. Press CTRL+SHIFT+V. 
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	To do this
	Press

	Select one character to the right.
	SHIFT+RIGHT ARROW

	Select one character to the left.
	SHIFT+LEFT ARROW

	Select to the end of a word.
	CTRL+SHIFT+RIGHT ARROW

	Select to the beginning of a word.
	CTRL+SHIFT+LEFT ARROW

	Select one line up (with the cursor at the beginning of a line).
	SHIFT+UP ARROW

	Select one line down (with the cursor at the beginning of a line).
	SHIFT+DOWN ARROW

	Select an object (when the text inside the object is selected).
	ESC

	Select another object (when one object is selected).
	TAB or SHIFT+TAB until the object you want is selected

	Select text within an object (with an object selected).
	ENTER

	Select all objects.
	CTRL+A (on the Slides tab)

	Select all slides.
	CTRL+A (in Slide Sorter view)

	Select all text.
	CTRL+A (on the Outline tab)
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	To do this
	Press

	Delete one character to the left.
	BACKSPACE

	Delete one word to the left.
	CTRL+BACKSPACE

	Delete one character to the right.
	DELETE

	Delete one word to the right. 
NOTE The cursor must be between words to do this.
	CTRL+DELETE

	Cut selected object or text.
	CTRL+X

	Copy selected object or text.
	CTRL+C

	Paste cut or copied object or text.
	CTRL+V

	Undo the last action.
	CTRL+Z

	Redo the last action.
	CTRL+Y

	Copy formatting only.
	CTRL+SHIFT+C 

	Paste formatting only. 
	CTRL+SHIFT+V

	Open Paste Special dialog box. 
	CTRL+ALT+V
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	To do this
	Press

	Move one character to the left.
	LEFT ARROW

	Move one character to the right.
	RIGHT ARROW

	Move one line up.
	UP ARROW

	Move one line down.
	DOWN ARROW

	Move one word to the left.
	CTRL+LEFT ARROW

	Move one word to the right.
	CTRL+RIGHT ARROW

	Move to the end of a line.
	END

	Move to the beginning of a line.
	HOME

	Move up one paragraph.
	CTRL+UP ARROW

	Move down one paragraph.
	CTRL+DOWN ARROW

	Move to the end of a text box.
	CTRL+END

	Move to the beginning of a text box.
	CTRL+HOME

	Move to the next title or body text placeholder. If it is the last placeholder on a slide, this will insert a new slide with the same slide layout as the original slide.
	CTRL+ENTER

	Move to repeat the last Find action.
	SHIFT+F4
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	To do this
	Press

	Move to the next cell.
	TAB

	Move to the preceding cell.
	SHIFT+TAB

	Move to the next row.
	DOWN ARROW

	Move to the preceding row.
	UP ARROW

	Insert a tab in a cell.
	CTRL+TAB

	Start a new paragraph.
	ENTER

	Add a new row at the bottom of the table.
	TAB at the end of the last row
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1. Press TAB OR SHIFT+TAB to select the object that you want. 
2. Press SHIFT+F10 for the shortcut menu. 
3. Use the DOWN ARROW until Worksheet Object is selected, press RIGHT ARROW to select Edit, and press ENTER. 
NOTE The name of the command in the shortcut menu depends on the type of embedded or linked object. For example, an embedded Microsoft Office Excel worksheet has the command Worksheet Object, whereas an embedded Microsoft Office Visio Drawing has the command Visio Object.
[image: Hide All]Format and align characters and paragraphs
Change or resize the font
NOTE You must first select the text that you wish to change to use these keyboard shortcuts.
	To do this
	Press

	Open the Font dialog box to change the font.
	CTRL+SHIFT+F

	Increase the font size.
	CTRL+SHIFT+>

	Decrease the font size.
	CTRL+SHIFT+<


Apply character formats
	To do this
	Press

	Open the Font dialog box to change the formatting of characters.
	CTRL+T

	Change the case of letters between sentence, lowercase, or uppercase.
	SHIFT+F3

	Apply bold formatting.
	CTRL+B

	Apply an underline.
	CTRL+U

	Apply italic formatting.
	CTRL+I

	Apply subscript formatting (automatic spacing).
	CTRL+EQUAL SIGN

	Apply superscript formatting (automatic spacing).
	CTRL+SHIFT+PLUS SIGN

	Remove manual character formatting, such as subscript and superscript.
	CTRL+SPACEBAR

	Insert a hyperlink.
	CTRL+K


Copy text formats
	To do this
	Press

	Copy formats.
	CTRL+SHIFT+C

	Paste formats.
	CTRL+SHIFT+V


Align paragraphs
	To do this
	Press

	Center a paragraph.
	CTRL+E

	Justify a paragraph.
	CTRL+J

	Left align a paragraph.
	CTRL+L

	Right align a paragraph.
	CTRL+R
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You can use the following keyboard shortcuts while you are running your presentation in Slide Show view.
	To do this
	Press

	Start a presentation from the beginning.
	F5

	Perform the next animation or advance to the next slide.
	N, ENTER, PAGE DOWN, RIGHT ARROW, DOWN ARROW, or SPACEBAR

	Perform the previous animation or return to the previous slide.
	P, PAGE UP, LEFT ARROW, UP ARROW, or BACKSPACE

	Go to slide number.
	number+ENTER

	Display a blank black slide, or return to the presentation from a blank black slide.
	B or PERIOD

	Display a blank white slide, or return to the presentation from a blank white slide.
	W or COMMA

	Stop or restart an automatic presentation.
	S

	End a presentation.
	ESC or HYPHEN

	Erase on-screen annotations.
	E

	Go to the next slide, if the next slide is hidden.
	H

	Set new timings while rehearsing.
	T

	Use original timings while rehearsing.
	O

	Use mouse-click to advance while rehearsing.
	M

	Re-record slide narration and timing
	R

	Return to the first slide.
	Press and hold Right and Left Mouse buttons for 2 seconds

	Show or hide the arrow pointer
	A or =

	Change the pointer to a pen.
	CTRL+P

	Change the pointer to an arrow.
	CTRL+A

	Change the pointer to an eraser
	CTRL+E

	Show or hide ink markup
	CTRL+M

	Hide the pointer and navigation button immediately.
	CTRL+H

	Hide the pointer and navigation button in 15 seconds.
	CTRL+U

	View the All Slides dialog box
	CTRL+S

	View the computer task bar
	CTRL+T

	Display the shortcut menu.
	SHIFT+F10

	Go to the first or next hyperlink on a slide.
	TAB

	Go to the last or previous hyperlink on a slide.
	SHIFT+TAB

	Perform the "mouse click" behavior of the selected hyperlink.
	ENTER while a hyperlink is selected


TIP You can press F1 during your presentation to see a list of controls.
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	To do this
	Press

	Play or pause media
	ALT+P

	Stop media playback
	ALT+Q

	Go to the next bookmark
	ALT+END

	Go to the previous bookmark
	ALT+HOME

	Increase the sound volume
	ALT+UP ARROW

	Decrease the sound volume
	ALT+DOWN ARROW

	Seek forward
	ALT+SHIFT+RIGHT ARROW

	Seek backward
	ALT+SHIFT+LEFT ARROW

	Nudge forward
	ALT+SHIFT+CTRL+RIGHT ARROW

	Nudge backward
	ALT+SHIFT+CTRL+LEFT ARROW

	Mute the sound
	ALT+U
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The following keys are for viewing your Web presentation in Microsoft Internet Explorer 4.0 or later.
	To do this
	Press

	Move forward through the hyperlinks in a Web presentation, the Address bar, and the Links bar.
	TAB

	Move back through the hyperlinks in a Web presentation, the Address bar, and the Links bar.
	SHIFT+TAB

	Perform the "mouse click" behavior of the selected hyperlink.
	ENTER

	Go to the next slide.
	SPACEBAR
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Use the following keyboard shortcuts in the Selection pane.
To launch the Selection pane, press Alt, then H, then S, then L, and then P.
	To do this
	Press

	Cycle the focus through the different panes.
	F6

	Display the context menu.
	SHIFT+F10

	Move the focus to a single item or group.
	UP ARROW or DOWN ARROW

	Move the focus from an item in a group to its parent group.
	LEFT ARROW

	Move the focus from a group to the first item in that group.
	RIGHT ARROW

	Expand a focused group and all its child groups.
	* (on numeric keypad only)

	Expand a focused group.
	+ (on numeric keypad only)

	Collapse a focused group.
	- (on numeric keypad only)

	Move the focus to an item and select it.
	SHIFT+UP ARROW or SHIFT+DOWN ARROW

	Select a focused item.
	SPACEBAR or ENTER

	Cancel selection of a focused item.
	SHIFT+SPACEBAR or SHIFT+ENTER

	Move a selected item forward.
	CTRL+SHIFT+F

	Move a selected item backward.
	CTRL+SHIFT+B

	Show or hide a focused item.
	CTRL+SHIFT+S

	Rename a focused item.
	F2

	Switch the keyboard focus within the Selection pane between tree view and the Show All and Hide All buttons. 
	TAB or SHIFT+TAB

	Collapse all groups. 
NOTE The focus must be in the tree view of the Selection pane to use this shortcut.
	ALT+SHIFT+1

	Expand all groups.
	ALT+SHIFT+9


To assign custom keyboard shortcuts to menu items, recorded macros, and Visual Basic for Applications (VBA) (Visual Basic for Applications (VBA): A macro-language version of Microsoft Visual Basic that is used to program Microsoft Windows-based applications and is included with several Microsoft programs.) code in Office PowerPoint 2007, you must use a third-party add-in, such as Shortcut Manager for PowerPoint, which is available from OfficeOne Add-Ins for PowerPoint.
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